Analyzing PDFs with Citavi 5
Introduction
Just Like on Paper ............................................................................................................... 2
Methods in Detail
Highlight Only (Yellow) ..................................................................................................... 3
Highlighting with a Main Idea (Red) ............................................................................ 4
Adding Direct Quotations (Blue) ................................................................................... 5
Adding Indirect Quotations (Purple) ........................................................................... 6
Adding Summaries (Green) ............................................................................................. 7
Adding Comments (Orange) .......................................................................................... 8
Adding a Comment to an Item (Orange) ................................................................... 9
Adding Tasks (Turquoise) .............................................................................................. 10
Special Cases
Saving Image Quotations .............................................................................................. 11
When Text in a PDF cannot be Highlighted ........................................................... 12
Adding Abstracts and Tables of Contents ................................................................ 13
Adding Keywords ............................................................................................................. 14
Hints
Hints for Selecting Text .................................................................................................. 15
Creating and Correcting Links ..................................................................................... 16
Deleting Knowledge Items and Highlights ............................................................. 17
Using Shortcuts ................................................................................................................. 18
PDF Analysis on Multiple Devices and in a Group
Understanding Layers ..................................................................................................... 19
Giving Copies of Annotated PDFs to Others .......................................................... 20
Viewing PDFs with an External PDF Reader ............................................................ 21
Editing PDFs with an External PDF Reader .............................................................. 22
Using PDFs in Different Group Scenarios ................................................................ 23
C5-PDF-EN-web1

Introduction – 2

Just Like on Paper
In Citavi 5 you can analyze texts as you’re used to doing on paper.
1.

The yellow highlighter lets you quickly mark important sections in a text.

2. You can use the red highlighter when you want to mark an important section in a text that you
might want to cite later on.

These two methods are used in all disciplines. For those who need to analyze texts more
closely, Citavi offers many additional options:
3. If you want to analyze a passage closely or save its exact wording or main ideas, you can save it as
a direct quotation, indirect quotation, summary, or comment. Text can also be saved as an
abstract, table of contents, or keyword. You can even assign tasks to a text passage.

Pick and choose from among these tools to find the best analysis methods for yourself.
One important note before getting started: highlight colors cannot be changed. This
ensures that you can share annotations with others.

Try it Out for Yourself!
Start Citavi 5 and open a PDF in the preview to try all of the features described in this
guide. In the Reference Editor every reference with an attachment is designated by the
paperclip icon .


Open the PDF from the navigation pane by double-clicking the paperclip

.



If you don’t have any PDFs in your project, use the text by Max Weber in the example project. In
Citavi click Window > Welcome screen >
Open sample project.

Please note: Read-only PDF files cannot be edited. In Citavi read-only PDF files are
designated by a lock
on the bottom left of the preview pane.
Table of Contents

Methods in Detail – 3

Highlight Only (Yellow)
The yellow highlighter lets you quickly set off important sections of a text. Yellow
highlights are only visible in your PDF and are not saved as knowledge items. The yellow
highlighter is ideal for quickly going through a text and picking out important sections.

Quickly Highlight in Yellow
1.

Click the yellow highlighter

.

2. The highlighter is now enabled. Select the interesting passages in your text to highlight them. The
highlighter will remain enabled.
When to use: This method is useful for quickly surveying a text. You can later go back and analyze
important passages more closely.

Highlight (Less Quickly) in Yellow
1.

Select text using the Text selection tool

2. Click the yellow highlighter
enabled.

.

. The selected text is highlighted, but the highlighter does not stay

When to use: This method is good if you’re analyzing texts in detail right from the start and want
to easily switch between yellow highlighting and the other annotation options.

Saving Yellow Highlights as Knowledge Items
Yellow highlights only appear in your PDF and are not also saved as knowledge items. However, you
can later change a yellow highlight so that it is saved as a knowledge item, for example, if you later
decide you would like to save a text passage as a direct quotation.
1.

Click a yellow highlight. The highlight is selected and the annotation options are displayed in the
preview:

2. Select one of the options (information on each of the options can be found in the following
pages). The yellow highlight changes color and the text is saved as the corresponding knowledge
item.
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Highlighting with a Main Idea (red)
In Citavi 5 we’ve introduced the red highlighter for highlighting important text passages
and quickly saving them with a keyword or main idea.

Quickly Highlight in Red
1.

Click the red highlighter

.

2. The highlighter is now enabled. Select short passages or important terms.
3. Your highlight is saved as a core statement and appears on the Quotations, comments tab.
Ideally, you won't need to make changes to the core statement, especially if you've highlighted a
term or succinct idea. Enter categories, groups, keywords, and page numbers as needed.
4. Continue highlighting.
When to use: Red highlights make it easy to save the most important ideas in a text along with the
page numbers on which they were discussed. This method is practical for quickly reviewing texts. You
don't need to write any paraphrases or summaries or decide whether or not to save a direct quotation.
You can always do that later on if you want. By clicking Show in PDF
you can jump directly to the
highlighted text passage – either from the Knowledge Organizer or while writing your text using the
Word Add-In (see page 16). Then you can decide if you just need a simple reference or if you want to
paraphrase or directly quote the passage.

Highlight (Less Quickly) in Red
1.

Select text with the Text selection tool

2. Click the red highlighter
remain enabled.

.

. Citavi highlights the text in red, but the red highlighter does not

3. Same as Step 3 above.
When to use: This method is good if you want to switch between red highlighting and other
annotation options. For example, you could save direct quotations and create comments or
summaries, which will then help you later on while writing your paper. You could use the red
highlighter for passages you don’t want to cite directly, but which you’ll refer to in your text with ”cf“.
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Adding Direct Quotations (Blue)
Use direct quotations if you want to save the exact wording of a text passage. With a single
mouse click you can transfer the text to Citavi. However, you should be careful with some
PDFs – see step 4.

Selecting Text and Creating a Direct Quotation
1.

Use the text selection tool

to select the text you want to highlight:

2. Click Direct quotation . The selected text is highlighted in blue and a knowledge item is created
on the Quotations, comments tab. The core statement is created automatically from the first
highlighted words.
3. Edit the core statement. Enter categories, groups, keywords, and page numbers as needed.
4. Double-check the quotation text. Sometimes you might need to make corrections. For example,
if you created a quotation out of several separate text passages, you'll need to insert ellipses for
the omitted text. If a quotation extended over two pages, you'll have an unnecessary line break.
From some PDFs the formatting (bold, italics) can't be imported. From others you might see
unnecessary hyphens. Make any necessary corrections in the quotation window. To open it, select
the direct quotation on the Quotations, Comments tab and click Open in window .
5. Changes. Anytime you shorten the text of a quotation or make insertions, you should not change
the meaning of the quotation and you must designate your changes according to the conventions
of your academic discipline. Click Open in window to open the quotation in the quotation
window.
6. Comments. If you want to add your own comments to a quotation, insert a new paragraph and
add the comment in brackets with your name or initials. To avoid any mix-up, we recommend
creating adding the comment as a separate knowledge item (see page 9 under adding a
comment).
When to use: The number of direct quotations you save depends on the text, but also on your text
analysis preferences. Citavi supports many different methods.
Some Citavi users only save direct quotations if they’re sure that they’ll want to use them in their
document. As a result, they’ll only save a limited number of these quotations in their projects. Instead,
they’ll rely more on indirect quotations, summaries, etc.
Other users save direct quotations almost exclusively. Later when writing their papers, they’ll decide if
they want to cite something word-for-word, use a paraphrase, or insert a simple reference.
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Adding Indirect Quotations (Purple)
Use indirect quotations if you want to restate the main ideas of a text passage in your own
words. If you just want to refer to a text passage without having to formulate a paraphrase,
use the red highlighter (see page 4). If a text passage is a longer section or chapter, create
a summary instead (see page 7).

Select Text and Create an Indirect Quotation
1.

Use the text selection tool
displayed:

to select the text you want to highlight. The icon toolbar is

2. Click Indirect quotation . The selected text is highlighted in purple and a core statement
appears in the new quotation on the Quotations, Comments tab. Citavi generates the core
statement automatically using the first few words in the selection.
3. If necessary, make changes to the core statement to better reflect your understanding of the text
passage. Enter categories, groups, keywords, and page numbers as needed.
4. Enter a paraphrase of the original text in the Text box. If you use any terms or exact wording
from the original text, set it off in quotation marks.
5. Comments. Indirect quotations should not change the original meaning of the text passage. Of
course, some interpretation is involved any time you restate the meaning of a text in your own
words. It can be a fine line between an „objective“ restatement and a „subjective“ comment. Try to
clearly distinguish between the two. If you want to add a comment to an indirect quotation, make
sure it’s readily distinguishable from the indirect quotation. For example, use a new paragraph and
place your text in square brackets with your initials. To make it even easier keep comments and
quotation separate, create a comment as a separate knowledge item and add it to the indirect
quotation. See Adding comments on page 9.
When to use: It makes sense to add indirect quotations when analyzing important texts whose
contents you later want to discuss in your paper more closely. Academic disciplines dealing with the
study of texts often use this method. Writers in these disciplines will often summarize the current state
of discussion and then extend it through their own contributions. Other disciplines tend to primarily
use short citations of thematically related sources (see page 4).
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Adding Summaries (green)
Use summaries to reformulate the main ideas of a longer section of text, such as a chapter,
in your own words. If you want to paraphrase a shorter text passage, create an indirect
quotation (see page 6).

Selecting a Text Passage and Adding a Summary
1.

Use the text selection
tool to select the text you want to highlight. If you want to summarize an
entire chapter or subchapter, you can simply select the heading. The icon toolbar is displayed:

2. Click Summary . The selected text is highlighted in green, a green highlight appears in the
margin, and a core statement appears in the new summary on the Quotations, Comments tab.
Citavi generates the core statement automatically using the first few words in the selection.
3. If necessary, make changes to the core statement to better reflect your understanding of the text
passage. Enter categories, groups, keywords, and page numbers as needed.
4. Enter a summary for the original text in the Text box. If you use any terms or exact wording from
the original text, set it off in quotation marks.
5. Margin and text highlights. When you’re done editing the summary, the text highlight will
disappear. Only the margin highlight will remain visible. When you hover over the margin
highlight, the text highlight will temporarily appear. Click the margin highlight to display the text
highlight.
When to use: Most journal articles include abstracts containing a summary of the entire text (to
save abstracts, see page 13). In this case, there’s not much of a need for you to come up with your
own summary. It’s a different case altogether for longer texts that you later might want to reference in
your paper. In any discipline that uses a great deal of text analysis, summaries have a similar
importance to indirect quotations (see page 6). Summaries can also be useful if you are reading some
of the central texts in a discipline or are analyzing an author’s oeuvre.
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Adding Comments (Orange)
Create a comment for a text passage if you want to save you own comments, evaluations,
or critical remarks on a text passage. If a text passage inspires a new idea, you can save it
as a comment. If an idea is not related to a text passage, you can use the thought
knowledge item instead. And if your comment involves a task (for example „These claims
sound a bit exaggerated. Verify.“) then you should create a task for the text passage (see
page 10).

Selecting a Text Passage and Adding a Comment
1.

Use the text selection tool
displayed:

to select the text you want to highlight. The icon toolbar is

2. Click Comment . The selected text is highlighted in orange, an orange highlight appears in the
margin, and a core statement appears in the new comment on the Quotations, Comments tab.
Citavi generates the core statement automatically using the first few words in the selection.
3. If necessary, make changes to the core statement to better reflect your understanding of the text
passage. Enter categories, groups, keywords, and page numbers as needed.
4. Write your comment in the Text box and add your name or initials if desired (see below).
6. Margin and text highlights. When you’re done editing the comment, the text highlight will
disappear. Only the margin highlight will remain visible. When you hover over the margin
highlight, the text highlight will temporarily appear. Click the margin highlight to display the text
highlight.
When to use: Use comments to save you own thoughts on a text passage that you later want to
include in your paper. If you’re working on a project with others, make sure to add your name to the
comment so other members know it’s from you. The other group members can then add their own
comments with their own initials.

Alternatively...
If you already added a text passage as a quotation, etc. and want to comment on it, you
can add a comment to the knowledge item rather than to the text passage itself.
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Adding a Comment to an Item (orange)
If you have already saved the text passage you want to comment on as a knowledge item,
you can add a comment to the knowledge item.

Adding a Comment to an Existing Knowledge Item
1.

On the Quotations, Comments tab, select the knowledge item that you want to add the comment
to.

2. On the Quotations, Comments tab, click New

.

3. On the dropdown menu, click Add comment to item. The quotation window opens. The core
statement, page range, categories, and groups are added automatically from the selected
knowledge item.
4. Enter your comment in the Text box and click OK to close the window. On the Quotations,
comments tab a new comment appears underneath the corresponding knowledge item. To the
right of it you will see the broken link
icon.
5. Click the broken link , select the text passage in the PDF the comment is based on, and then
click the broken link
again. The icon changes to the link
icon to show that the link between
the comment and PDF has been established.
When to use: See usage notes on page 8.
You can add comments directly to a direct or indirect quotation (see page 5, no. 6, and page 6, no. 5).
The disadvantage is that you won't be able to see if a quotation has had a comment added to it in the
list of knowledge items. For this reason, we recommend saving standalone comments as described
here and on page 8.
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Adding Tasks (Turquoise)
Sometimes you might read something that gives you an idea you want to pursue later on.
You can add tasks to text passages for this purpose:

Selecting Text and Assigning a Task
1.

Use the text selection tool
displayed:

2. Click the Task

to select the text you want to add a task to. The icon toolbar is

icon.

3. Select a task from the menu. The selected text is highlighted in turquoise, a turquoise highlight
appears in the margin, and the new task appears on the Tasks & Locations tab.
4. If you want to add additional information to the task (due date, priority, etc.), open the task
window by double-clicking the task.
Margin and text highlights. When you’re done editing the task, the text highlight will disappear.
Only the margin highlight will remain visible. When you hover over the margin highlight, the text
highlight will temporarily appear. When you click the margin highlight, Citavi will switch to the task
on the Tasks & Locations tab.
When to use: Four tasks related to text analysis are already predefined:
Discuss: If you want to discuss the thesis statement, findings, or conclusions of a paper or passage with
your team members or with your advisor. Examine and assess: If you find a claim in the text that you
doubt the accuracy of or want to double-check. Go through bibliography: If the bibliography likely
contains additional sources that you might want to add to Citavi (see Analyzing a Bibliography). Read:
A publication was cited either in the text or bibliography that you want to read.
You can also add your own tasks to the list of predefined tasks.

Table of Contents

Special Cases – 11

Saving Image Quotations
Use image quotations to save images or tables from a PDF. Citavi saves the image as a
high-resolution JPEG. However, many PDFs contain low-resolution pixel images. As a result,
these images will not have a high resolution in Citavi.

Technical Background


Perhaps you want to save a table as text in order to edit it to fit the formatting in your paper. Since
the table is in PDF format, you are unable to do so. If you try, you will likely have to do a lot of
extra work. Saving the table as an image quotation is usually much easier.



To save a clear image, you do not need to change the settings in the Citavi preview. It doesn’t
matter which size you display the PDF in; the image quotation is always saved in DIN A4 format
with approximately 4200 x 5900 pixels. This resolution guarantees a high-quality image in your
paper later on, as long as the original image was also of high-quality, which unfortunately isn’t
always the case.

Selecting an Image and Adding it as an Image Quotation
1.

Use the snapshot tool
to drag a border around the part of the PDF that you want to save as an
image quotation. The icon toolbar is displayed with the available options:

2. Click Image quotation

. Citavi opens the quotation window.

3. Edit the Caption. The text from the caption will later be visible in the Word Add-In on the
Knowledge tab and is inserted as a caption in Word when you insert the image with the Add-In. In
the Caption field you should also include copyright information if applicable. Add the original
caption of the image in the Description field if your caption differs from it.
4. Often images, figures, and tables you find in a PDF also come from other sources. If the original
source is available, you should use it. If not, you should create a secondary citation. Add the
original source information to the Description field.
5. In the quotation window, click OK. The image is saved in the Citavi Attachments folder for the
project. It also appears on the Quotations, Comments tab. The highlighted region of the PDF is
shown in blue.
When to use: Images are often used to depict facts, relationships, processes, and results in a
compact and understandable way. For this reason you might want to save them as quotations. As
described above, it’s important to make sure that you keep track of the source information for the
image.
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When Text in a PDF cannot be Highlighted
In some PDF files or sections of PDF files, text cannot be highlighted or copied. This can
occur if the text was originally scanned as an image and later converted to PDF format. If
this is the case, use the snapshot tool to link direct quotations, indirect quotations,
summaries, comments, and tasks with the corresponding location in the PDF.

Using the Snapshot Tool
1.

Use the snapshot tool
displayed:

to drag a border around the image or table. The icon toolbar is

2. If you want to add a direct quotation, select Image quotation
. Citavi opens the
quotation window. Enter the core statement in the caption field and fill in the other fields as you
would for a normal direct quotation (see page 5).
If you don’t want to have to type the text later on, you can use an optical character recognition
program to convert the images to text. Your image quotations are saved with the Citavi short title
in the Citavi 5 folder under Projects > [Project name] > Citavi Attachments. However, it’s usually
not worth the trouble unless you’re working with a great deal of image quotations and can do the
conversion all at once. If you only have a couple of text images in your project, it’s probably easier
just to retype the text.
3. Other knowledge items can be directly linked with a section you’ve selected with the snapshot tool.
Simply click on the knowledge item you want to use in the icon toolbar. Then, fill out the form on
the Quotations, Comments tab as you normally would (see pages 4 through 10).
4. Citavi uses in-text highlights for direct and indirect quotations and for red highlights. Summaries,
comments, tasks, etc. have marginal highlights. The colors follow the pattern described on pages 4
through 10.
When to use: Saving text as an image is a workaround. It can be useful for
linking your annotations with the exact text passage even if the PDF is only available in image format.

Alternatively...
You can also take a screenshot, use an OCR program to convert the image to text, and then copy it to
the text box of the Direct quotation form. This method works for image PDFs and for PDFs that are
read-only. However, it may not be worth the additional effort.
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Adding Abstracts and Tables of Contents
Abstracts and tables of contents are saved in the Reference Editor on the Content tab only.
They do not appear in the Knowledge Organizer or in Citavi‘s Word Add-In.

Adding Abstracts and Tables of Contents
1.

Use the text selection tool
to select the text you want to save as an abstract or table of
contents. The icon toolbar is displayed:

2. Click More

.

3. Select Abstract or Table of contents from the menu. The selected text is highlighted in gray, a
gray highlight appears in the margin, and Citavi opens the Contents tab. The abstract or table of
contents is displayed there.
4. If you want to edit the abstract or table of contents, simply click the blue link that appears above
the text.
5. Margin and Text highlights. When you’re done editing the abstract or table of contents, the text
highlight will disappear. Only the margin highlight will remain visible. When you hover over the
margin highlight, the text highlight will temporarily appear. Click the margin highlight to display
the text highlight. Citavi opens the Contents tab.
When to use: Journal articles often already include an abstract. Tables of contents are usually only
available for longer texts. Both give you a quick overview of the contents of the PDF. Since you already
saved the PDF in Citavi, you may decide that you don’t need to also save the abstract and table of
contents. One advantage is that you can then quickly view both on the Overview tab. In addition,
Citavi’s search feature also searches abstract and tables of content fields. This lets you quickly see the
relevance of a text for a particular search query.
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Adding Keywords from a PDF
Keywords can easily be added to Citavi from a PDF and are useful for describing
references.

Adding Keywords from a PDF
1.

Many journal articles include keywords underneath the abstract. These are usually keywords that
were selected either by the author or publisher. Instead of copying keywords one-by-one, use the
text selection tool
. The icon toolbar appears:

2. Click More

or press the W key (see page 18).

3. Select Keywords from the menu. A window appears in which the keywords are listed as Citavi
interpreted them. Usually, you won’t need to make any changes, unless the original source used
uncommon punctuation.
4. If necessary, correct the list by selecting a different separator and clicking OK. Citavi opens the
Context tab where the keywords are displayed. Keywords are not highlighted in the PDF file.

Alternatively...
1.

Even if the PDF doesn’t include keywords, you might find terms or combinations of words in the
text that you want to save as keywords. Use the text selection
tool to select the text you want
to save as a keyword. The icon toolbar appears:

2. Click More

or press the W key (see page 18).

3. Select Keywords from the menu. If you only select one word, it will automatically be saved on the
Contents tab. If you save a combination of words, the keywords window will open. Continue as
described above under point 4.
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Hints for Selecting Text
Selecting Text
1.

Click the text selection tool:

:

2. As soon as you’ve selected text, the icon toolbar is displayed with all available options. Place the
mouse above the various icons to view information (tooltips) about each option. Then, select the
option you want to use:

Sometimes it’s not this straightforward. If this is the case, use the hints below.

Hint 1: Combine multiple text passages in one text selection
Problem: You want to cite text that continues on another page. In PDF format it’s not possible to
select across a page break without also including footers, headers, and page numbers that appear
in the selection.
Or, you may want to save a single statement from a long sentence that contains relative clauses,
text set off by dashes, or comments in parentheses.
Solution: After selecting the text passage, press and hold the Ctrl key. You then can add additional
text to the selection. Most word processors also let you add text to a selection in this way.

Hint 2: Removing parts of a passage from a text selection
Problem: You accidentally selected too much text.
Solution: Press and hold the Shift key. At the same time, press and click while dragging the mouse
over the text you want to remove from the selection.
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Creating or Correcting Links
Automatic Links
Highlighted text passages are automatically linked in Citavi to the following places:
 The Quotations, comments tab
 The Knowledge Organizer
 The Citavi Word Add-In.
The Show in PDF icon
PDF.

lets you know that the item is linked to a specific place in the

When you click the link, Citavi opens the PDF in the preview and highlights the corresponding text
passage or image. This lets you easily double-check the context of the quotation or other knowledge
item. You can also double-click a highlight in the PDF to jump to the corresponding entry on the
Quotations, Comments tab.

Missing Links
Missing links are designated by the Broken Link
icon. Clicking the icon displays a
message telling you how you can correct the link:

Yellow Highlights are Not Linked
You’ll see links for all annotations you make in a PDF, except for yellow highlights. As a
result, yellow highlights cannot be viewed in the Knowledge Organizer or Word Add-In.
However, this also has its advantages (see page 3).
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Deleting Knowledge Items and Highlights
Deleting a Knowledge Item
1.

Right-click a knowledge item on the Quotations, Comments tab.

2. Select Delete quotation on the menu and click OK on the Window that appears. The knowledge
item and its corresponding highlight in the PDF are deleted.
3. To delete a task, click the Tasks & Locations tab, right-click the task, and select Delete task.

Deleting and Changing a Highlight
It doesn’t make much sense to delete a highlight but retain the knowledge item it links to, unless the
highlight is in the wrong place in your PDF file. To correct it, you first need to delete the incorrect
highlight.
1.

Click the text highlight. The highlight appears darker. Alternatively, click the margin highlight to
display the corresponding text highlight.

2. Right-click the text highlight.
3. Select Delete from the shortcut menu. Select one of the two options in the window that appears:

4. Select Only the selected highlight if you want to save the knowledge item but add a different
highlight to it. Click OK to delete the highlight. The Broken Link
icon appears next to the
knowledge item. Select the text you want to link and click the icon to join it to the knowledge item.
For direct quotations, you should double-check if the text of the quotation needs to be changed as
well.
5. For yellow highlights, tasks, abstracts, and tables of contents, the process follows the same pattern.
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Working with Shortcut Keys
Sometimes it’s easier to use shortcut keys rather than the mouse.
Shortcuts for selection tools:
E =

Text selection

Text Selection

G =

Snapshot

Graphics Selection

Shortcuts for highlights:
Y =

Highlight

Yellow

Q =

Highlight in red

Quick

D =

Direct quotation

Direct Quote

F =

Indirect quotation

The F is next to the D key

S =

Summary

Summary

C =

Comment

Comment

T =

Task

Task

A =

Abstract

Abstract

W =

Keywords

Keywords

Additional shortcuts for working with PDFs:
Ctrl + Down arrow

Next page

Ctrl + Up arrow

Previous page

Pos1

Go to page 1

End

Go the last page

Up arrow

Scroll up

Down arrow

Scroll down

Left arrow

Scroll left

Right arrow

Scroll right

Ctrl + Mouse wheel

Zoom

Ctrl +F3

Open or close search field

F3

Go to next search result

Shift + F3

Go to previous search result

F8

Go to next highlight

Shift + F8

Go to previous highlight

F9

Export PDF annotations

Delete

Delete

Esc

Cancel
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Understanding Layers
Image to the right: As a default, Citavi does
not save annotations in the PDF file. Instead,
annotations are saved in a transparent layer over
the text. The PDF is not changed in any way.
This has two advantages: First, editing and saving
annotations is faster, especially if the PDF is saved on a
network drive or in the cloud. Second, PDFs can then be
used by multiple people each saving their own individual
annotations (see page 23).

Image to the left: The PDF itself will only be
changed if you export your annotations to the
PDF. After that you can view your highlights in
an external PDF reader.
When to use: If you want to give the PDF file to another
person (see page 20) or if you want to continue working
with it on the go in an external reader on a tablet or
other device (see page 21-22).

Image to the right: All annotations made in an
external PDF reader are saved in the PDF, but only
highlights will be displayed in Citavi and will be
available for further editing.
Technical background: If you open a PDF file that was
annotated in another PDF reader, all the notes, arrows, lines,
etc. will be ignored and only the highlights will be copied into
the Citavi layer. They'll appear in the same color as in the
external reader but will be displayed as underlines instead of
highlighted text. See how you can continue working with your
highlights on pages 21-22.
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Giving Copies of Annotated PDFs to Others
Your annotated PDF files can easily be shared with
another person, as long as they aren’t licensed files
that the recipient doesn’t have a license for. All you
need to do is to export the highlights to a copy of
the PDF.


The PDF file you are working with in Citavi remains
unaltered.



Only your highlights are visible in the copy of the PDF.
Any text you save for these highlights (quotations,
comments, etc.) is not exported to the copy of the PDF.*

Exporting PDF Annotations
1.

In the preview pane, on the Tools menu, select Export PDF annotations…

2. In the window that appears, select whether you want to export annotations for the displayed PDF
file or all PDF files in your project.

3. Important: Do not export highlights into the existing file. Instead, select a location on your
computer or on an external drive. Only clear the Save Citavi reference information in the PDF
metadata option if you think the bibliographic information in your Citavi project is incorrect.
4. Click OK. The copy containing all of your highlights is saved with the short title and can be sent to
your colleagues.

** If the recipient is also a Citavi user, you can send all the PDFs you’ve saved in Citavi. Simply export the
references to a new project (File > Export). You can then compress the project folder and send it as
ZIP file.
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Viewing PDFs with an External PDF Reader
You can easily read and highlight new PDFs with an external PDF reader. However, a more
involved analysis should be done within Citavi.

Importing PDF Annotations
1.

You’re away from the computer on which Citavi is
installed but are reading PDFs on another device,
such as a tablet or smartphone.

2. You can highlight interesting sections of the text with
the reader’s yellow highlighter. The first time you
are importing from another reader, only use yellow
highlights (see page 3 and the bottom of page 19).
3. Scenario A:
If you haven’t already saved the PDF file in your
Citavi project, copy the PDF file to your computer. In
Citavi click References > Import > PDF files.
Scenario B:
If the PDF file is already saved in your Citavi project in
the folder Citavi 5 > Projects > [Project name] >
Citavi Attachments, overwrite the old version with
the new, freshly edited version.
4. In Citavi the yellow highlights from the external PDF reader are displayed as yellow underlines, see
image. If desired: click a highlight and then save it as a knowledge item as described from page 3
onwards.
5. You can also save the yellow underlines as yellow Citavi highlights. However, it’s not really
necessary and takes additional time.

Please note
It’s even easier to work with a new PDF file in Citavi. However, the method above is a
good alternative if you’re working away from your computer and Citavi is not available.
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Analyzing PDFs with an External Reader
If you want to more intensively analyze a PDF file with
an external reader rather than just making simple
highlights as described on page 21, it can be a bit
difficult. To make it easier, save the PDF file on a
network on a server or in the cloud. This lets you easily
work with a single PDF file across all devices and saves
you from having to copy the file back and forth.

Continue Analyzing PDF Files in an External Reader
1.

Analyze the PDF in Citavi first.

2. To continue working with a PDF file in an external reader, export the highlights to the existing PDF
file by clicking Tools > Export PDF annotations… (see figure above).
3. When analyzing the PDF in an external reader, only use
highlights (see page 19). Use colors that roughly
correspond to the Citavi color system, for example blue for
text passages you later want to save as direct quotations
or purple for sections you want to save as indirect
quotations.
4. The next time you open the PDF in Citavi, the external
highlights are automatically copied in the layer and
displayed as underlines (see figure to the left). This lets you
easily distinguish new external highlights from internal
highlights.
5. Change all highlights made in the external reader to the
corresponding knowledge item in Citavi. The underlines
are changed to Citavi highlights.
6. If you want to analyze the PDF in an external reader again,
you will need to export the annotations to the PDF file a
second time (see figure to the right).

Please note
This process is a bit time-consuming and
recommended only in special circumstances. It can go
a bit faster if you choose the corresponding option
under File > Project properties > Paths.
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Using PDFs in Different Group Scenarios
A repository of PDFs for multiple projects
Workgroups in universities, organizations, or companies can use Citavi to create a
repository of PDFs saved on a local server or in the cloud. Group members can then save
copies of PDFs from the project for their own individual or group projects.
To save disk space, they can also link to the PDF directly. In this case, PDF annotations
should never be exported to the original PDF (see page 20). Instead, each group member
should simply work with layers in their Citavi projects (see page 19).
In this way a single PDF file can be used in multiple projects and annotated individually by
each group member.

A common project with shared PDF annotations
The work of analyzing and annotating PDF articles is usually shared among several group
members. Annotations can be used, added to, or corrected by all group members. Citavi
supports different ways of working with texts. Ideally, group members should decide which
annotation features they want to use and how they want to use them before beginning a
project.
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